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4 Workbook 

Once you have started Excel, you will see a workbook with one sheet (spreadsheet). In the 

Excel versions up to 2010 there were several sheets. If the windows are not displayed on the 

full area of the screen, maximize the Excel program window to full screen mode. To do this, left-

click the Maximize icon . In this course document, the Excel windows are restored down for 

reasons of space. 

 The  icon closes windows! 

One sheet is divided into 16,384 columns (A to XFD) and 1,048,576 rows (1 to 1,048,576). You 

can enter contents into each cell - the interface between rows and columns. The cell cursor 

 is moved around in the sheet using the mouse or the arrow (cursor movement) keys. 

Each cell can be activated. 

 

The workbook 

The active cell address, i.e. the position of the cell cursor, is displayed 

in the top left-hand corner in the name field. If, for example, you move 

the cell cursor into column B, row 9, the active cell address will be B 9 . 
 

4.1 Moving within the sheet 

To move efficiently around a sheet with 17 billion cells, you can use either the mouse or the 

following keys and shortcuts. 

 

The  Transition navigation keys control box in Excel Options has to be 

deactivated first: Select the File tab (File menu), Options, Advanced and then the 

Lotus Compatibility category: 
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Excel options, Advanced page 

(Æ) Cell cursor 1 cell to the right 

(æ) Cell cursor 1 cell to the left 

(¼) Cell cursor 1 cell down 

(½) Cell cursor 1 cell up 

(Home) Cell cursor to the start of row 

(End) (Enter) Cell cursor to the end of row 

 (only with sheets containing data) 

(Ctrl)+(Home) Cell cursor to the start of sheet 

(Ctrl)+(End) Cell cursor to the end of sheet 

 (only with sheets containing data) 

(PgDown) 1 screen page down 

(PgUp) 1 screen page up 

(Alt)+(PgDown) 1 screen page to the right 

(Alt)+(PgUp) 1 screen page to the left 

(Ctrl)+(PgDown) Next sheet 

(Ctrl)+(PgUp) Previous sheet 

(F5) address The "Go To" key (F5) opens up a 

dialog box. Enter the cell address, 

e.g. B9, and press the (Enter) key 

or click [_OK_]. 

 

 

The Go To window 

The shortcuts with the (End) key send the cell cursor to the end: 

(End) (Æ) 

(End) (æ) 

(End) (¼) 

(End) (½) 

It is necessary to differentiate between 2 scenarios: 

 Cell cursor is in a cell with an entry: 

The cell cursor jumps in the direction of the arrow to the last cell with an entry or to the end 

of the sheet. 

 Cell cursor is in a cell without an entry: 

The cell cursor jumps in the direction of the arrow to the first cell with an entry or to the 

start of the sheet. 

http://www.dettmer-verlag.de/


 Seminarunterlage Excel 2016 Einführung in Englisch  

 25 Musterseite aus dem Dettmer-Verlag, D-76889 Kapellen 

www.dettmer-verlag.de 

Notes on the keys (Ctrl) and (End): 

(Ctrl)+ Hold down the (Ctrl) key while pressing another button. 

(End) Briefly press the (End) key and then release. End Mode then appears on the status 

bar. Now press the other key. 

 

Jump to the lower right cell with the (End) key and the arrow keys (¼) (Æ) 

 
If you press the cursor control keys, e.g. (Æ), (¼), (Home), (End), in the numeric 

keypad (number pad) on the right, the numeric entry must be switched off. In that 

case, the NumLock light above the keypad is off. To switch, press the NumLock key 

((Numº)) in the keypad. There may be differences with laptops. 

Scrolling with the wheel mouse 

With the wheel mouse, also known as the scroll mouse or IntelliMouse, there is a wheel 

positioned between the two mouse buttons. You can use it to scroll quickly through large 

sheets. The Intellimouse wheel features several options, e.g.: 

 Move the mouse pointer to the sheet and turn the wheel without pressing it. 

Turn the wheel forwards or backwards to scroll up or down respectively. 

 Point the mouse pointer to the sheet and briefly press the wheel. The mouse 

pointer changes its appearance, e.g. four small triangles with one dot. Its 

appearance depends on the connected mouse or mouse program. The same 

symbol in gray is displayed in the background. Move the black pointer  

above or below the gray background symbol to scroll up or down in the Excel 

sheet. If the mouse pointer  is on the right or left of the gray symbol, you can 

shift to the right or left. The more distance between the gray background 

symbol and the black mouse symbol, the faster you can scroll through the 

sheet. Click the wheel or a button to close the scroll function. 
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4.2 Zoom 

You can use the wheel mouse to zoom the sheet between 10% and 

400%: Move the mouse pointer to the sheet, hold down the (Ctrl) key and 

push the wheel forwards to zoom in and backwards to zoom out. 

You can also zoom in and out without using the wheel mouse: 

 

Zooming function on the status bar 

 Click the percentage at the bottom right on the status bar to open the 

Zoom dialog box and select the new zoom size  or enter the 

percentage in the Custom box. Close the box by clicking [_OK_]. 

 

Select or enter the 
percentage 

 Or you can zoom the view by holding down the left mouse button and moving the  slider or  

clicking the  plus and  minus buttons on the status bar. 

4.3 Entering data 

In the following table, the names of five employees are entered that made suggestions for 

improvements last year. The figures show the employee savings amounts: 

 

Entering data 

Move the cell cursor to cell A2 and enter the name Heintz. As soon as the first letter is entered, 

notice what happens to the mode display at the bottom left of the screen: The mode switches 

from Ready to Enter. 

4.4 Saving entries 

A cell entry can be completed in various ways: 

 with the (Enter) key or

 with an arrow key: (Æ)(æ)(¼)(½) or 

 with a click on the  Enter icon (chack mark) to the left of the formula bar (see following 

image). 
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Completing an entry with an arrow key (without (Enter)) is convenient if other data has to be 

entered in an adjacent cell as in the example. 

4.5 Canceling entries 

As long as the data is not entered, you can cancel the entry with the (Esc) key or by clicking the 

 Cancel icon (cross) to the left of the formula bar: 

 

 Important parts of a workbook (here: in Edit mode) 

4.6 Changing entries 

If you discover an error in a cell after you have entered the data, there are several options to 

change the entry. Requirement: Excel is in Ready mode! Position the cell cursor in the cell to be 

edited: 

 Overwrite the old entry. When entering data it is not important whether the cell contains 

data or is empty. 

 If you just want to change a part of the cell entry or expand the entry, press the (F2) key. 

The mode display in the bottom left of the status bar switches to Edit. Click in the formula 

bar or double-click the cell to switch to Edit mode. You can make the changes directly in 

the cell or in the formula bar at the top. 

The following keys are activated in Edit mode 

(æ) (Æ) Moves the flashing cursor sideways. 

(Home) Moves the cursor in front of the first characters. 

(End) Moves the cursor behind the last character. 

(Bksp) Deletes the character to the left of the cursor or the selected characters. 

(Del) Deletes the character to the right of the cursor or the selected characters. 

(Insert) Switches between Insert and Overtype mode. In Overtype mode, 

Overtype can appear at the bottom left on the status bar. 

(Alt)+(Enter) Inserts a line break within the cell at the cursor position (new line). 

(Esc) Cancels Edit mode and returns to Ready mode. Changes are ignored. 
Mouse click on the Cancel icon to abort editing . 

(Enter) Closes editing. 
Mouse click on the Enter icon to confirm and complete editing . 

Selecting individual characters 

You can only select cell contents in Edit mode. You can select data directly in the cell or in the 

formula bar at the top. Besides deleting the selected characters, you can also change the format 

Name box
Insert Function

Enter

Cancel

Formula bar

Column heading

Row heading

Select All button
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of text within a cell, e.g. font, size, color (font on page 59 onwards). Select the characters you 

want using the mouse or the keyboard: 

 Move the mouse pointer in front of the first character you want to select. Keep the left 

mouse button pressed and drag the mouse over the characters. 

 Or move the cursor in front of the first character. Keep the (Shift) key pressed down and 

select the characters using an arrow key, e.g. (Æ).  

Insert or overtype mode 

You can check in Edit mode whether you are working in Insert or Overtype mode by activating 

a button on the status bar. Right-click the status bar as described on page 135. Activate the 

following line in the configuration menu: 

 

Show this line 

Experience shows that users mostly work in Insert mode. However, it often happens that the 

(Insert) key is unintentionally pressed and the computer switches to Overtype mode. 

Your task 

Enter all the data from the spreadsheet on page 26. 

 
Please do not use the lower or upper case letter O (for Oscar) to replace the digit 0 

(zero). Excel recognizes these as 3 different characters. 

4.7 Calculating sums 

Once you have entered the figures from the 1st to the 4th quarter for all five names, you can 

now calculate the annual sums of the individual employees. 

For the first time, the benefits of spreadsheet calculations are clearly visible. Before Excel, data 

had to be collected using the typewriter. 

You need the annual sum from the employee Heintz in cell F2. The 4 figures are entered in cells 

B2, C2, D2, and E2. Now, all you have to do is link all four cells together using a formula: 

=B2+C2+D2+E2. 

There are several methods for entering this formula: 

1. Move the cell cursor to cell F2 and enter: 

=B2+C2+D2+E2 

Save the entry with the (Enter) key. The first character is the important equals sign (=). 

Every formula or calculation in Excel has to start with this sign. 

2. In cell F3, enter the equals sign (=) only. Now, move the arrow key (æ) to cell B3. The 

mode display in the bottom left-hand corner switches to Point. =B3 is now displayed in the 

formula bar at the top. Enter (+), the cell cursor jumps to F3. Now, move to cell C3. Then 

enter (+) again and move to cell D3; again enter (+) and move to cell E3. The following 

formula appears in the formula bar: 

=B3+C3+D3+E3 

The data is now entered. No more plus signs are added. Press (Enter) to complete the 

entry. 
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The second method might seem complicated but you will soon be working in Point mode in 

Excel quite often in the future. 

The Sum icon 

Another option to calculate sums in Excel is the AutoSum icon on the Home tab in the 

Editing group. The cell cursor is in cell F4. Click the left part of the icon. Excel adds the 

SUM function to the cell. Now click cell B4, hold down the left mouse button and select 

B4:E4. By doing this, you create a flashing frame. In addition, an info box appears 

under the function. 

 

 

Sum function with info box 

Press the (Enter) key to enter. 

In AutoSum, Excel now selects the next adjacent cell above or on the left. You can change the 

cell using the mouse or the arrow keys. 

Difference between the screen display and the cell contents 

Click cell F4 again. The sum: 199656.4 appears in the spreadsheet where the cell cursor is 

located. In contrast, the actual cell content is displayed in the formula bar at the top: 

= SUM(B4:E4) 

These functions will be described in more detail from page 49 onwards. 

The sums in cells F5 and F6 are still missing. Leave these cells empty for the time being. The 

missing formulas will be copied into these cells. The next step is to save your work. 
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13 Filling Data 

To fill a data series, Excel provides the Fill command. The range has to be selected before you 

open the menu of the Fill button. However, you do not always know the exact range or final 

value (stop value) before you start. It's important to select a large range for unknown series. 

With a negative step value (increment), it's important to remember that the end value must be 

smaller than the start value. 

An example: 

In a new, blank worksheet, a row of numbers  should start with 25% and end at 3 % a step 

value (increment) of 0.5%. The stop value is smaller than the start value, this is why the step 

value has to have a negative suffix. 

1. Create a new workbook by clicking File menu, New, Blank workbook or press the 

(Ctrl)+(N) keyboard shortcut. 

2. Enter the value 25% in cell B1 and close the entry.  

3. The range is not yet known so select a very large area: 

Select the range B1:B100 

4. Open the Home tab and click the Fill button in the Editing 

group and select Series…. 

5. In this dialog box, select the following: 

Series in:  Columns 

Type:   Linear 

Trend:   no chack mark! 

Step value: -0.5% 

Stop value: 3% 

 

Filling the series 

 

Editing group 

 

Fill button submenu 

 



With percentage values, e.g. 3%, the percentage sign % must also be entered 

otherwise it equals 300%! 

6. Click [_OK_]. 

7. Format the number series in the percentage format with one decimal place. 
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13.1 Filling in date values 

Date values can also be entered as the step and stop values. In the series type, select  Date 

and as a date unit you can select: 

Day 

Weekday 

Month 

Year. 

A date or time format may also have to be specified for the range. 

13.2 Autofill using the mouse 

Autofill using the mouse can also facilitate work greatly. Here's an example:  

1. Write the word January into cell B1 and close the entry. 

2. Return the cell cursor to cell B1. 

3. Point the mouse to the fill box  (page 45) in the bottom right-hand corner of the cell cursor. 

The mouse cross turns black: +. 

4. Hold down the left mouse button and expand the selection until you reach the range or the 

month name you want. A ScreenTip of the month name appears to the right of the mouse 

cross: 

 

Autofill of month name 

5. The context icon  that appears features different options to change the insert later. 

 
If you need the same month name several times below or next to each other, hold 

down the (Ctrl) key while performing step 4. 

13.3 Flash Fill 

The feature called Flash Fill can be used to fill data in your worksheet. As soon as Excel re-

cognizes a pattern in your procedure, Flash Fill provides a list with suggested data. Press the 

(Enter) key and Excel enters the data according to this list. Or you use the Flash Fill button. 

Assumed, all email addresses in your company are structured like this 

FirstName.LastName@company.com 
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and you want to display the first and last names in seperate columns. We have prepared such a 

list for you with the E-mail list.xlsx file. Below, we want to try out both versions of flash fill: the 

suggestion list and the Flash Fill button. 

In cell B2, enter the first name from cell A2 (in this case Rachel) and complete the entry with the 

(Enter) key. In cell B3, start typing the first name from cell A3. Now, flash fill provides a list with 

all first names from the A column. Press the (Enter) key to accept the suggestions. 

 

Flash fill list 

If the data is entered with flash fill, the Flash Fill Options 

context icon  appears beside it with which you can undo the 

automatic data entry. 

Now, type the last name from cell A2 (Heintz) into cell C2 and 

complete the entry by clicking the (Enter) key. In cell C3, click 

the Flash Fill button on the Data tab in the Data Tools group. 

Excel automatically fills the C column with the other last names. 

 

Flash Fill options 
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14 Database 

In principle, the term database means nothing new. You most probably have access to 

databases at home or at work even if they are not referred to as such. 

Just visualize a database like a large card box with lots of index cards. Let's assume you had to 

create and maintain a list of suppliers in your office. This involves following many standard 

procedures. Compare the computer database procedure with the index card system in the table 

below. You will notice that the basic principle of a computer database shares a lot of the same 

features with a paper database. 

Index card box Database 

Install an index card system. Create a new database. 

Open an existing card box. Open an existing database. 

Complete new index cards for new suppliers 

and add cards to the box. 

Add new addresses. 

Delete those suppliers with whom we no longer 

do business. 

Delete addresses we no longer require. 

Search for the relevant supplier for orders 

orders. 

Search for specific suppliers. 

Change the address if a supplier moves to new 

premises. 

Change addresses. 

Close the card box once you have completed 

your work. 

Close the database and exit the program. 

All index card activities have their equivalent in the database. The structure of the index card is 

also mirrored in the database. Index cards often have pre-printed segments or boxes where you 

fill in the relevant information. 

 

An Access database sheet 

The computer database saves the addresses in a list. The columns are referred to as fields or 

better data fields and the rows as data sets. Data fields are identified by their names, the field 

names. 
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14.1 Preliminary considerations - new database 

Before you create a new database, you first have to consider its structure, i.e. what it should 

look like. If you take your time with it now, you may save a lot of time later. 

The first consideration: 

 "What information do you require?" 

 "Which data do you need access to later?" 

 "Which data has to be sorted?" 

If you want to access last names, it is practical to create two separate data fields, one 

designated to the first name and one to the last name. On the other hand, the street number 

can be saved in the same field as the street name; it is very unusual to sort the database by the 

house number. However, it is advisable to create two separate fields for the zip code (postal 

code) and town/city. 

 If you're unsure, it is better to save items in separate data fields. 

14.2 Database ranges 

A complete database in Excel comprises 3 ranges: 

 List range 

The data sets are contained here. 

 Criteria range 

To filter certain data sets, enter the conditions here. 

 Output range 

The data sets that fulfill the search criteria (conditions) can be copied to the output area. 

Create a new, blank workbook by selecting File, New, Blank Workbook or press the (Ctrl)+(N) 
keyboard shortcut. Save the book as Customer Database 

List range 

Leave the first 8 rows blank to insert the criteria. Therefore, start with row 9, and enter the field 

names in range A9:G9 in separate cells: 

FIRST NAME    LAST NAME    CITY STATE    ZIP CODE     DATE OF BIRTH    SALES 

Now select these field names, i.e. range A9:G9, and define the name Database for this range 

as described on page 75. 

Data form 

You can type data directly into cells as you have already been doing. However, Excel  

enables you to enter data in a form. To do this, the Form icon has to be on the Quick 

Access Toolbar. Find out on page 134 how to add an icon to the toolbar. 
 

 

Quick Access Toolbar with the Form icon 
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Select range A9:G9 (Database) and click the 

Form icon. A blank data form appears on the 

screen. 

 

A blank data form 
 

 
If the following message appears, range A9:G9 has not been named. Click [_OK_] and 

the entry mask will appear nonetheless. 

 

To specify the column heading, click [_OK_]. 

Now fill in the individual fields. Enter the data from the following screen. To switch to the next 

entry field in the form, press the 

(Tab) key. 

If a data set is filled in, press the (Enter) key to open a new, blank form for the next set. 

 

Database list with small green triangles in E12 and E19 and a context symbol 
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However, a problem arises if you need to enter numbers: If the number starts with 0 (zero), 

Excel will omit the zero. This is obviously not acceptable with certain zip codes (Barre and 

Hartford in our example). 

For zip codes, Excel offers two solutions to this problem, but for telephone area codes and 

similar types of numbers, there is only one: 

 When entering a zip code or another number starting with 0 in the data form, enter an 

apostrophe ' as the first character. An example is shown in the previous image in cell E19 

displayed in the formular bar at the top. Or before opening the data form, select the range 

for the zip codes (E10:E19) and format the cells as text using the Format Cells dialog box 

(page 54). Nonetheless, after completing the entry of cells E12 and E19, you will see a 

small green triangle  in each case and a context symbol  for the current cell. You can 

ignore this error message or click the context symbol and select the Ignore Error 

command (image page 72). 

 An alternative for 5-digit zip codes only: Before opening the input screen, select the entire 

zip code range (E10:E19) or the entire column, open the Format Cells dialog box and 

select the Special format Zip Code: 

 

Special format 

Once you have entered the last data set in the form, 

click [Close]. 

 

The data form with the 10th data set 
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14.3 Filters 

You don't often work with all the data sets in the list. Frequently, you have to access specific 

information. Excel offers you very convenient ways of filtering data: 

 Autofilter 

 Advanced filter. 

Autofilter 

The Autofilter function allows you to access specific data sets 

extremely quickly: 

1. Move the cell cursor to the first field name, to FIRST NAME. 

2. Select: Data, Sort & Filter group, Filter icon. 

3. Now, a drop-down arrow  appears next to every field name. 

 

Data tab, 
Sort & Filter group 

 

Autofilter with drop-down arrows  next to the field names 

4. Click the arrow  next to the CITY field and select Chicago 

as the filter. In order to do this deactivate the  (Select All) 

check box and activate  Chicago. Click [_OK_]. 

5. In the list range, you will now see the filtered data sets only. 

The down arrow  next to CITY has also changed to 

indicate that the filter has been activated for this field. 

6. To show all data sets again, open the CITY filter list  and 

select Clear Filter. 

Advanced filter 

The advanced filter offers you extended filtering options. However, 

you have to set up a criteria range first in which you enter the 

filter conditions, i.e. the criteria. 

 

Clearing the filter 
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Criteria range 

For the Criteria range, you need a row with the field names and for now only one blank row 

below it. Copy the range  with the field names (A9:G9) and paste it into cell A3. 

Output range 

The data sets which meet the criteria (conditions) can be copied by Excel (including the row with 

the field names) and inserted into the output range, e.g. I3:O3. 

 
No other data must be contained in the entire range below the output range (up to 

and including the last row). They will otherwise be deleted! 

 

The 3 ranges in the vertically split window 

14.4 Entering criteria 

To access certain information, type the criteria into the criteria range below the relevant field 

name. Criteria are also referred to as conditions or filters. 

Below the CITY field name, in the 

criteria range, enter the filter 

Chicago in cell C4. Then move 

the cell cursor to the top left cell 

A9 in the list range, i.e. FIRST 

NAME the field name. Now select 

 

Entry in criteria range 

Data tab, Sort & Filter group, . 
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Select and enter: 

1.  Copy to another location. 

2. The list range $A$9:$G$19 is already entered. 

3. Criteria range: A3:G4 

4. Copy to: I3:O3 

If you apply the ranges in Point mode , the 
addressing is absolute. When typing, you can omit the 
sheet name and the $ sign. 

 

5. Click [_OK_]. 

 

A special filter 

The data sets with the CITY Chicago were copied to the output range: 

 

Output with advanced filter 

Filtering with an operator 

1. Please delete the filter Chicago in cell C4.  

2. Now, let's only display data sets which contain a higher number than 60000 in the ZIP 

CODE field: 

> 6 0 0 0 0  

Enter this condition in the criteria range in the ZIP CODE column (field) in cell E4 and then 

copy the data sets to the output range. 

 
Caution: First move the cell cursor to the top left cell A9 in the list range (FIRST 

NAME) before you click the  icon. 

3. Clear the filter in the ZIP CODE field. Now, select the data sets with an amount below 5000 

in the SALES field: 

< 5 0 0 0  
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Filter with multiple conditions 

For queries with more than one condition, there are two different possibilities: 

 A N D  link 

The filtered data sets have to meet all conditions. To do this, enter the conditions into one 

row in the criteria range. 

You may have to define the criteria range again: it includes the row with the field names 

plus one row. 

 O R  link 

The filtered data sets only have to meet one of the conditions. To do this, type the 

conditions into rows one below the other in the criteria range. 

You may have to define the criteria range again: it includes the row with the field names 

and all rows which contain one of the search criteria. 

The zip code problem 

The Special format Zip Code (Postal code) has already been introduced on page 119. A 

deliberate choice has been made not to recommend using the Zip Code format in this example. 

The reason is that the following problem occurs for other numbers beginning with a zero as well, 

such as article and invoice numbers, and the Zip Code special format cannot be used for these 

numbers. 

If you want to filter out all data sets with a ZIP CODE less than 60000, the data sets of Barre 

and Hartford will not be copied. These zip codes start with a 0 (zero) and are in the Text type. 

To solve this problem, insert another OR link in cell E5: >0* The asterisk * sign acts as a joker 

and you may recognize this character from the search function in the Windows file explorer. 

Now that the criteria range has changed, you'll have to enlarge it by one row in the Advanced 

Filter dialog box: A3:G5. 

 

Zipcodes under 60000 

14.5 Exercise 

1. Filter out all data sets with a zip code above 40000 and sales above 5000: 
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Zip code above 40000 and sales above 5000 

2. Save the workbook. 

14.6 Sorting 

Although the Sort command can also be found on the Data tab, it can be used on any range. 

Now let's sort our database by SALES. Excel can automatically recognize a list: 

1. Move the cell cursor to the SALES field name in the list range. 

2. On the Data tab, in the Sort & Filter group, click the Sort button. 
 

3. In the Sort dialog box, select: 

- Sort by: SALES. 

-  My data has headers (to prevent the sorting of field names). 

 

Sort by SALES 

4. Click [_OK_]. 

For simple sorting tasks, you can also use the icons on the right: From A to Z or 

From Z to A.    
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14.7 Summary: database 

Preliminary considerations - new database 

Before you create a new database, you first have to think about the layout with the field 

names. 

Database ranges 

A complete database in Excel comprises three ranges: list range, criteria range, output 

range. 

List range 

The field names are entered side by side in separate cells in the first row of the list range. 

Criteria range and output range 

Copy the range with the field names from the list range and paste it into two separate 

ranges in the worksheet. There should be no data below the output range. 

Filter 

If you want to access specific data only, you can use the autofilter or advanced filter. 

Autofilter 

Move the cell cursor to the first field name and click Filter (Data tab, Sort & Filter group). 

You can now select a filter for each field name from a list. 

Advanced filter 

1. Enter the criteria (condition) in the criteria range under the relevant field name, e.g. for 

the CITY field the word Chicago. 

2. On the Data tab, in the Sort & Filter group, click the Advanced button. 

3. In the dialog box, select or enter:  Copy to another location, List range, Criteria 

range, Output range (= Copy to). 

AND link 

The filtered data sets have to meet all conditions. To do this, you are required to enter the 

conditions into one row in the criteria range. 

OR link 

The filtered data sets must meet just one of the conditions. To do this, you are required to 

enter the criteria into rows one below the other in the criteria range. 

Sorting 

To sort a list, move the cell cursor to the column by which the rows are to be 

sorted. On the Data tab, in the Sort & Filter group, click the Sort button, or 

click the icons From A to Z or From Z to A. 
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